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Operational Precautions and
Limitations 1
Note: Before operating the system, carefully read all of the sections of this guide.

This section contains general safety-related information and provides regulatory compliance
information. It also describes potential hazards and associated warnings for the system and the
precautions that should be taken to minimize the hazards.

In addition to this section, for information about the symbols used in the laboratory environment,
on the system, and in this documentation, refer to the section: Glossary of Symbols. For site
requirements, refer to the document: Site Planning Guide.

General Safety Information
To prevent personal injury or system damage, read, understand, and obey all of the safety
precautions and warnings in this document, the manufacturer chemical safety data sheets
(SDSs), and product label information. Labels are shown with internationally recognized
symbols. Failure to heed these warnings could result in serious injury.

This safety information is intended to supplement federal, state, provincial, and local
environmental health and safety (EHS) regulations. It does not cover every safety procedure that
should be practiced. Ultimately, the user and the organization are responsible for compliance
with federal, state, provincial, and local EHS regulations and for maintaining a safe laboratory
environment.

Refer to the correct laboratory reference material and standard operating procedures.

Documentation Symbols and Conventions
The following symbols and conventions are used throughout the guide.

DANGER! Danger signifies an action that leads to severe injury or death.

WARNING! Warning signifies an action that could cause personal injury if
precautions are not followed.

CAUTION: Caution signifies an operation that could cause damage to the system or
corruption or loss of data if precautions are not followed.

Operational Precautions and Limitations

BioPhase 8800 System For BioPhase 8800 Driver for
Empower™ Users
6/116

Operator Guide
RUO-IDV-05-15014-A



Note: Note emphasizes significant information in a procedure or description.

Tip! Tip provides useful information that helps apply the techniques and procedures in the text
for a specific need and provides shortcuts, but is not essential to the completion of a procedure.

Regulatory Compliance
This system complies with the regulations and standards listed in this section. For dated
references, refer to the declaration of conformity included with the system and the individual
system components. Applicable labels have been affixed to the system.

Australia and New Zealand
• Electromagnetic Compatibility (EMC): Radio Communications Act 1992 as implemented in

these standards:

• Electromagnetic Interference—AS/NZS CISPR 11/ EN 55011/ CISPR 11 (Class A). Refer
to the section: Electromagnetic Interference.

Canada
• Electromagnetic Interference (EMI): CAN/CSA CISPR11. This ISM device complies with

Canadian ICES-001. Refer to the section: Electromagnetic Interference.

• Safety:

• CAN/CSA C22.2 No. 61010-1

Europe
• Electromagnetic Compatibility (EMC): Electromagnetic Compatibility Directive 2014/30/EU

as implemented in these standards:

• EN 61326-1

• EN 55011 (Class A)

Refer to the section: Electromagnetic Compatibility.

• Safety: Machinery Directive 2006/42/EC as implemented in these standards:

• EN 61010-1

• Waste Electrical and Electronic Equipment (WEEE): Waste Electrical and Electronic
Equipment Directive 2012/96/EEC, as implemented in EN 40519. Refer to the section: Waste
Electrical and Electronic Equipment.

• Packaging and Packaging Waste (PPW): Packaging and Packaging Waste Directive
94/62/EC

Operational Precautions and Limitations
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• RoHS Restriction of Hazardous Substances: RoHS Directive 2011/65/EU and
2015/863/EU

United States
• Radio Emissions Interference Regulations: 47 CFR 15, as implemented in FCC Part 15

(Class A)

• Safety: Occupational Safety and Health Regulations, 29 CFR 1910, as implemented in these
standards:

• UL 61010-1

International
• Electromagnetic Compatibility (EMC):

• IEC 61326-1

• IEC CISPR 11 (Class A)

Refer to the section: Electromagnetic Compatibility.

• Safety:

• IEC 61010-1

Electrical Precautions
WARNING! Electrical Shock Hazard. Do not remove the covers. Removing
the covers might cause injury or malfunctioning of the system. The covers
need not be removed for routine maintenance, inspection, or adjustment.
Contact a SCIEX Field Service Employee (FSE) for repairs that require the
covers to be removed.

• Follow required electrical safe work practices.

• Use cable management practices to control electrical cables. This will decrease the chance of
a tripping hazard.

For information about system electrical specifications, refer to the document: Site Planning
Guide.

Mains Supply
Connect the system to a compatible mains supply as instructed in this guide.

Operational Precautions and Limitations
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WARNING! Electrical Shock Hazard. Use only qualified personnel for the
installation of all of the electrical supplies and fixtures, and make sure that
all of the installations adhere to local regulations and safety standards.

WARNING! Electrical Shock Hazard. Use only the mains supply cables
supplied with the system. Do not use mains supply cables that are not
properly rated for the operation of this system.

WARNING! Electrical Shock Hazard. Make sure that the system can be
disconnected from the mains supply in an emergency by disconnecting the
mains supply cable from the mains supply inlet at the back of the system. Do
not block the back of the system.

Protective Earth Conductor
The mains supply must include a correctly installed protective earth conductor. The protective
earth conductor must be installed or examined by a qualified electrician before the system is
connected.

WARNING! Electrical Shock Hazard. Do not intentionally interrupt the
protective earth conductor. Any interruption of the protective earth
conductor creates an electrical shock hazard.

Chemical Precautions
WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Identify whether decontamination is required before cleaning
or maintenance. If radioactive materials, biological agents, or toxic
chemicals have been used with the system, then the customer must
decontaminate the system before cleaning or maintenance.

WARNING! Environmental Hazard. Do not dispose of system components in
municipal waste. Follow local regulations when disposing of components.

• Identify which chemicals have been used in the system before service and regular
maintenance. For the health and safety precautions that must be followed for a
chemical, refer to the safety data sheet (SDS). For storage information, refer to the
certificate of analysis. To find a SCIEX safety data sheet or certificate of analysis, go to
sciex.com/tech-regulatory.

• Always wear assigned personal protective equipment, including powder-free gloves, safety
glasses, and a laboratory coat.

Note: Nitrile or neoprene gloves are recommended.

Operational Precautions and Limitations
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• Work in a well-ventilated area or fume hood.

• Avoid ignition sources when working with flammable materials, such as isopropanol,
methanol, and other flammable solvents.

• Take care in the use and disposal of any chemicals. There is a potential risk of personal injury
if correct procedures for handling and disposal of chemicals are not followed.

• Avoid skin contact with chemicals during cleaning, and wash hands after use.

• Collect all spent liquids and dispose of them as hazardous waste.

• Comply with all of the local regulations for the storage, handling, and disposal of
biohazardous, toxic, and radioactive materials.

System Safe Fluids
CAUTION: Potential System Damage. Do not use any other fluid until confirmation is
received from SCIEX that it does not present a hazard. This is not an exhaustive list.

CAUTION: Potential System Damage. Do not use organic solvents, such as methanol
or acetone, to clean the capillary window. Organic solvents can dissolve the adhesives,
leaving residue on the capillary window that might interfere with the detector.

Any substance in a BioPhase 8800 analysis kit, or referenced in an BioPhase 8800 System
Application Guide, can safely be used with the system. In addition, the following fluids can also
be used with the system. To determine compatibility with other chemicals, contact sciex.com/
request-support.

• Acids and Bases

The pH range is from 2 to 12.

• Acetic acid, up to 10%

• Sodium hydroxide, up to 1 M

• Hydrochloric acid, up to 1 M

• Reagents

• CE Grade Water

Physical Precautions
WARNING! Lifting Hazard. Use a mechanical lifting device to lift and move the
system. If the system must be moved manually, then at least four people are
required to move the system safely. Follow established safe lifting procedures. We
recommend the use of a professional moving service.

Operational Precautions and Limitations
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Environmental Precautions
Use qualified personnel for the installation of electrical mains, heating, ventilation, and plumbing
supplies and fixtures. Make sure that all of the installations comply with local bylaws and
biohazard regulations. For information about the required environmental conditions for the
system, refer to the document: Site Planning Guide.

Allow access space around the equipment when setting up the system.

WARNING! Biohazard. For biohazardous material use, always comply with local
regulations for hazard assessment, control, and handling. This system or any part
is not intended to act as a biological containment.

WARNING! Environmental Hazard. Follow established procedures for disposal
of biohazardous, toxic, radioactive, and electronic waste. The customer
is responsible for disposal of hazardous substances, including chemicals,
waste oils, and electrical components, in accordance with local laws and
regulations.

Electromagnetic Environment
Electromagnetic Compatibility
Basic Electromagnetic Environment: Environment existing at locations characterized by being
supplied directly at low voltage from the public mains network.

The equipment is intended for use in a basic electromagnetic environment.

Make sure that a compatible electromagnetic environment for the equipment can be maintained
so that the device will operate as intended. If the power supply line is subject to high electrical
noise, then install a surge protector.

Electromagnetic Interference
Group 1 Equipment: This equipment is classified as industrial, scientific, and medical (ISM)
equipment that might use RF energy for internal operation.

Class A Equipment: Equipment which is suitable for use in all establishments other than
domestic and those directly connected to a low voltage power supply network which supplies
buildings used for domestic purposes. [Derived from CISPR 11:2009, 5.3] Class A equipment
shall meet Class A limits.

CAUTION: Potential Radio Interference. This equipment is not intended for use in
residential environments and may not provide adequate protection to radio reception in
such environments.

Operational Precautions and Limitations
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This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC (Federal Communications Commission) Compliance Rules.

These limits are designed to provide reasonable protection against harmful interference when
the equipment is operated in a commercial environment. This equipment generates, uses,
and can radiate radio frequency energy and, if not installed and used in accordance with the
operator's manual, can cause harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference in
which case you will be required to correct the interference, at your own expense. Changes or
modifications not expressly approved by the manufacturer could void your authority to operate
the equipment.

Decommissioning and Disposal
WARNING! Environmental Hazard. Follow established procedures for disposal
of biohazardous, toxic, radioactive, and electronic waste. The customer
is responsible for disposal of hazardous substances, including chemicals,
waste oils, and electrical components, in accordance with local laws and
regulations.

Before decommissioning, decontaminate the entire system following local regulations.

When removing the system from service, separate and recycle different materials according to
national and local environmental regulations.

Note: SCIEX will not accept any system returns without a completed Decontamination Form.
Contact an FSE to obtain a copy of the form.

Do not dispose of system components or subassemblies, including computer parts, as unsorted
municipal waste.

Waste Electrical and Electronic Equipment
Follow local municipal waste ordinances for proper disposal provisions to decrease the
environmental impact of waste, electrical, and electronic equipment (WEEE). To safely dispose
of this equipment, contact a local Customer Service office for complimentary equipment pick-up
and recycling.

UV Radiation Precautions
WARNING! Ultraviolet Radiation Hazard. Avoid exposure to direct or reflected UV
radiation. Ultraviolet radiation is harmful to the eyes and skin. Do not operate the
UV source without required system safety interlocks.

Operational Precautions and Limitations
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Laser Precautions
This section is applicable for systems that have a laser-induced fluorescence (LIF) detection
system.

WARNING! Laser Hazard. Follow all local codes, regulations, standards and
internal requirements applicable to laser safety.

WARNING! Laser Hazard. Do not use equipment and controls or complete
procedures in a manner different from that documented in this guide. Doing so
might result in hazardous laser radiation exposure.

WARNING! Personal Injury Hazard. Do not look directly into the anticipated path of
the laser beam or at any specular reflections of the laser beam. Invisible ultraviolet
radiation from the laser can cause injury to the eyes.

WARNING! Personal Injury Hazard. Do not remove the outer cover of the laser
assembly. If the cover is not present, then exposure to potentially harmful laser
radiation is possible.

The LIF detection system contains a Class I laser system in a sealed module. The module
contains an embedded Class 3B laser component. The 3B classification means that direct
intrabeam viewing of this type of laser is always hazardous to personnel.

The laser assembly contains the laser and several other components in a sealed housing, and
has no user-serviceable parts. Service of the laser assembly is restricted to qualified SCIEX
Field Service Employees (FSEs). Therefore, the overall laser classification of the system is
Class 1, defined as lasers that are safe under reasonably foreseeable conditions of operation.

Qualified Personnel
Only qualified SCIEX personnel shall install, examine, and service the equipment. After installing
the system, the Field Service Employee (FSE) uses the Installation Qualification to orient the
customer on system operation, cleaning, and basic maintenance. SCIEX might not cover the
damage to a system under warranty if it is serviced by personnel not authorized by SCIEX.

Laboratory Conditions
Safe Environmental Conditions
The system is designed to operate safely under these conditions:

• Indoors

• Altitude: Up to 2,000 m (6,560 ft) above sea level

Operational Precautions and Limitations
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• Ambient temperature: 15 °C (59 °F) to 40 °C (104 °F)

• Relative humidity: 20% to 80%, non-condensing

• Mains supply voltage fluctuations: ± 10% of the nominal voltage

• Transient overvoltages: Up to the levels of Overvoltage Category II

• Temporary overvoltages on the mains supply

• Pollution Degree 2

Performance Specifications
The system is designed to meet specifications under these conditions:

• An ambient temperature of 15 °C to 30 °C (59 °F to 86 °F)

Over time, the temperature must remain within a range of 4 °C (7.2 °F), with the rate
of the change in temperature not exceeding 2 °C (3.6 °F) per hour. Ambient temperature
fluctuations exceeding the limits might result in shifts in migration time.

• Relative humidity from 30% to 70%, noncondensing.

Equipment Use and Modification
WARNING! Electrical Shock Hazard. Do not remove the covers. Removing
the covers might cause injury or malfunctioning of the system. The covers
need not be removed for routine maintenance, inspection, or adjustment.
Contact a SCIEX Field Service Employee (FSE) for repairs that require the
covers to be removed.

WARNING! Personal Injury Hazard. Use SCIEX-recommended parts only. Use of
parts not recommended by SCIEX or use of parts for any purpose other than their
intended purpose can put the user at risk of harm or negatively impact system
performance.

WARNING! Lifting Hazard. Use a mechanical lifting device to lift and move the
system. If the system must be moved manually, then at least four people are
required to move the system safely. Follow established safe lifting procedures. We
recommend the use of a professional moving service.

Use the system indoors in a laboratory that complies with the environmental conditions
recommended in the document: Site Planning Guide or contact an FSE.

If the system is used in an environment or in a manner not prescribed by the manufacturer, then
the performance and protection provided by the equipment might be impaired.

Operational Precautions and Limitations
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Contact an FSE for information on servicing the system. Unauthorized modification or operation
of the system might cause personal injury and equipment damage, and might void the warranty.
Erroneous data might be generated if the system is operated outside the recommended
environmental conditions or with unauthorized modifications.

Operational Precautions and Limitations
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Introduction 2
This guide describes the basic operation, troubleshooting, and maintenance of the BioPhase
8800 system. Read this guide thoroughly before using the product, and operate the product in
accordance with the instructions in this guide.

This guide provides safety instructions and precautions to make sure that the user operates the
system safely. Obey all Warning and Caution instructions provided in this guide.

Description
The BioPhase 8800 system is an eight-channel capillary electrophoresis system that can do
separations for up to 96 samples without user intervention.

The BioPhase 8800 system includes the following components:

• A touchscreen on the front panel

• A UV source and detector

• (Optional) A 488 nm laser and an LIF detection system

• Software to control the system and perform data acquisition, either:

• BioPhase software. An application for data analysis, the BioPhase Analysis software, is
included with BioPhase software,

• BioPhase 8800 driver for Empower™. Data analysis of data collected with the BioPhase
8800 driver for Empower™ cannot be analyzed with the BioPhase Analysis software.

The system uses pre-assembled cartridges, containing either eight bare-fused silica or eight
neutral capillaries.

SCIEX offers analysis kits designed to operate with the BioPhase 8800 system. The kits include
reagents and sample and reagent plates.

Related Documentation
This document assumes some knowledge of the Waters Empower™ software. For instructions
on general features of the Waters Empower™ software:

• Refer to the documentation supplied with the software.

• Click  on the Empower Start dialog

• Click Help in any of the Waters Empower™ software windows.

Introduction
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For detailed instructions on using the Waters Empower™ software for a specific capillary
electrophoresis application, refer to the following application guides:

• Capillary Isoelectric Focusing (cIEF) Analysis Application Guide

• CE-SDS Protein Kit Application Guide

• RNA 9000 Purity & Integrity Kit Application Guide

Waters Empower™ Software Terminology for
BioPhase Software Users
Users who have used the BioPhase 8800 system with the BioPhase software must become
familiar with the Waters Empower™ software terms.

Table 2-1 Waters Empower™ Software Terminology for BioPhase Software Users

BioPhase Software
Term

Waters Empower™

Software Equivalent
Description

No equivalents in
BioPhase software

Instrument Method A method containing system
parameters required for data
acquisition. Parameters are grouped
as general parameters, detector
parameters, and a time program.

Processing Method A method containing data processing
parameters.

Reporting Method A method to create a report showing
the results of the processing method.

Method Method Set A combination of an instrument
method, a processing method, and a
report method. Processing and report
methods are optional.

Sequence Sample Set Method A list of samples and associated
method sets that is sent to the
BioPhase 8800 system for data
acquisition. Optionally, the Waters
Empower™ software can do post-
acquisition data processing and
generate reports.

Introduction
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Table 2-1 Waters Empower™ Software Terminology for BioPhase Software Users
(continued)

BioPhase Software
Term

Waters Empower™

Software Equivalent
Description

Report Report A file containing information about the
results of the data acquisition. Reports
can also include information about the
organization generating the data. The
layout and appearance of a report can
be customized and saved as part of a
report template.

Sample inlet plate Plate The 96-well plate that holds the
samples to be analyzed.

Sample outlet plate Plate A plate with 8 troughs that contains the
gel or buffer required for the separation.

Regent inlet plate Plate The 96-well plate that holds the reagent
and rinse solutions.

Regent outlet plate Plate A plate with 8 troughs that collects
capillary waste.

Computer LAC/E module The computer that controls the
BioPhase 8800 system.

Introduction
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Hardware Overview
Figure 2-1 Front and Side Panel, with Plate Compartment Open

Item Description

1 Front panel

2 Power button

3 Plate compartment with door open

4 Optics door

Introduction
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Figure 2-2 Back Panel

Item Description

1 Mains supply connection and fuse holder

2 RJ-45 network connector

Introduction
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Cartridge
Figure 2-3 Cartridge Front

Item Description

1 Handle

2 Serial number label

3 Capillary inlets

4 Capillary outlet

5 Electrode

6 Capillary window and aperture

Introduction
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Figure 2-4 Cartridge Back

Item Description

1 Capillary window and aperture

2 Pressure outlet port

3 Coolant outlet port

4 Electrode

5 Capillary outlet

6 Coolant inlet port

7 Capillary inlets (from left to right, capillaries A to H)

8 Pressure inlet port

9 ID chip

10 Handle

Available Cartridges
The BioPhase 8800 cartridge is available with eight capillaries in the following configurations:
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• 50 µm i.d. × 30 cm bare-fused silica capillaries

• 50 µm i.d. × 30 cm neutral capillaries

The Sample Plate
The BioPhase 8800 system uses a 96-well sample plate.

To configure the plate for use in an automated liquid-handling system, refer to the section: Plate
Specifications.

Figure 2-5 Sample Plate

Item Description

1 Alignment notch

2 Chamfered corner

The Reagent Plate
To configure the plate for use in an automated liquid-handling system, refer to the section: Plate
Specifications.
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Figure 2-6 Reagent Plate

Item Description

1 Alignment notch

2 Chamfered corner
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The Outlet Plate
To configure the plate for use in an automated liquid-handling system, refer to the section: Plate
Specifications.

Figure 2-7 Outlet Plate

Item Description

1 Reagent wells

2 Overflow wells, leave empty

3 Chamfered corner

Theory of Operation
Capillary electrophoresis (CE) is a technology to separate and quantify sample components. In
CE methods, analytes migrate through electrolyte solutions under the influence of an electric
field. Analytes can be separated according to mobility or partitioning into an alternate phase
by noncovalent interactions. Additionally, analytes can be concentrated or focused by means of
conductivity or pH gradients.

Data acquisition on the BioPhase 8800 system is enabled using the BioPhase 8800 driver
for Empower™ in conjunction with the Waters Empower™ software. The Method Editors for
BioPhase System software, part of the BioPhase 8800 driver for Empower™, is used to develop
instrument and sample set methods.
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The UV Detection System
The UV detection system includes an ultraviolet light source, wavelength filters, and a
photodiode detector.

The UV source is a deuterium lamp with a wavelength range from 190 nm to 400 nm. Two
lenses focus and direct the output of the lamp through one of the wavelength-selecting filters.
The beam continues through the aperture in the cartridge and then through the detection
window, which is a section of the capillary that has been treated to remove the polyimide
coating. The transmitted beam continues to the photodiode. The light signal is converted to an
electrical signal, digitized, and then sent to the software for processing.

The filter holder has space for two filters. The BioPhase 8800 system is shipped with two 25 nm
bandwidth filters: 220 nm and 280 nm.

The Laser-Induced Fluorescence (LIF) Detection System
The LIF detection system is an optional component.

The LIF detection system uses a solid-state 488 nm laser light source. The excitation light is
transmitted from the laser to the capillaries in the cartridge. Substances in the capillary that
fluoresce at the laser wavelength are detected. The LIF detector measures and records this
fluorescence, which is shown as a peak on the electropherogram. The 520 nm emission filter is
provided with the instrument.

Interactions Between the BioPhase 8800 System and the
Waters Empower™ Software
The BioPhase 8800 system uses a cartridge that has eight capillaries. The separation occurs in
all eight capillaries at the same time.

To do the separation and then save the separation data, the Waters Empower™ software
uses the BioPhase 8800 driver for Empower™. When a run starts, the driver uses Empower
functions to start the separation for all eight capillaries. The BioPhase 8800 system then does
the separation. The progress status and data collected for eight capillaries can be seen in the
Trace View window in the Waters Empower™ software.

Data from all eight capillaries is sent to the driver on the Waters Empower™ software acquisition
server. The driver either saves the data from the capillaries one capillary at a time or starts a
new run. Refer to the section: What Causes a New Run. In summary, the separation is done at
the same time but the data is saved to the Empower database one capillary at a time.

This procedure is different from single sample injections done with the Waters Empower™

software, typically for liquid chromatography, which start to save data to the Empower database
when the injection starts.

The processing speed of the Waters Empower™ software and the network speed control the
length of time required to save the data. On a slow network, an interval between the time that
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the separation ends and the time that the data is saved to Empower database can occur. In the
Injections, Channels, Results, and other tabs in the Waters Empower™ software Project window,
the Date Acquired field shows the time that the data is saved. The result is that the values
in the Date Acquired field differ, even though the data was acquired at the same time. This
is consistent with the design and function of the Date Acquired field in the Waters Empower™

software.

The interval between the end of the separation and the time that the data is saved has
implications when a run is stopped by a user. Refer to the section: Stopping a Run.

Stopping a Run
When a sample set method is running and the system is in a busy state, actions from the
BioPhase 8800 driver for Empower™ Direct Control pane are not permitted. If the BioPhase 8800
driver for Empower™ is saving data and the system is in an idle state, Direct Control actions are
available but should not be used.

CAUTION: Potential Data Loss. Do not initiate any actions from the BioPhase 8800 driver
for Empower™ Direct Control pane during a run, even if the system status is idle. Any
actions might interfere with data acquisition.

If the run needs to be stopped before it is finished, the data that is saved into the database only
includes samples from the second to last row with red text. All of the data from the current row
(with red text) is not saved. To make sure that all required data is saved, either:

• Let the sample set method complete. When the method is complete, Abort button ( )

changes from red to green ( ).

• Wait until the data for the required sample is saved and the next injection starts, and then
stop the run.

Turn on the System and Log On
1. Press the power button on the front of the system.
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Figure 2-8 Instrument Locked Window

2. On the front panel, touch the screen to unlock the system and view the front panel log-in
screen.

3. Touch Log In.

Note: If the Username field is empty, then type Empower.
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Figure 2-9 Front Panel Login
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BioPhase 8800 System Front Panel 3
This section describes the ribbon, status panel, and functions available in the front panel home
page of BioPhase 8800 system.

Figure 3-1 Front Panel Home Page

BioPhase 8800 System Front Panel
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Front Panel: Ribbon
Figure 3-2 Ribbon Functions

Item Description

1 Touch to view light sources usage and software version details, and to turn
power to the instrument off.

2 Touch to view the home page.

3 Touch to view the Direct Control functions.

4 Touch to view the log.

5 Shows the cartridge status.

Note: The icon changes to green when the cartridge is loaded.

6 Touch to change the cartridge status to LOADED or EJECTED.

7 Touch to turn the UV lamp ON or OFF.

Note: After the lamp is turned on, a timer counts down from 30 minutes,
indicating the time remaining before the lamp is ready.

8 Touch to turn the LIF laser ON or OFF.

Note: After the laser is turned on, a timer counts down from 15 minutes,
indicating the time remaining before the lamp is ready. The LIF laser button
is unavailable if the LIF detection system is not installed on the instrument.
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Front Panel: Status
The status panel at the bottom of the front panel shows the system information and status.

Figure 3-3 Front Panel Status

Item Description

System Status

Shows the system status.

Action Progress

Shows the progress status of the current sample set method.

Method

Shows the instrument method name.

Shows the sample storage temperature.

Shows the cartridge temperature.

Shows the pressure.

Shows the voltage of the capillaries.

BioPhase 8800 System Front Panel
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Item Description

Shows the current of the capillary.

Shows the detector type.

Shows the coolant level.

Note: Green indicates an acceptable level, yellow indicates a low level,
and red indicates that the coolant is empty. The system will not operate if
the icon is red.

Indicates that an error occurred during the run.

Indicates that the system is being controlled by the Waters Empower™

software.

Touch to lock the front panel touchscreen.

Touch to log off.

Touch to stop the system.

If a sample set method is running, in the Run Samples window in the

Waters Empower™ software, click  (Abort).

Shows the current time and date.
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Front Panel Functions
Figure 3-4 Front Panel Home Page Buttons

Item Description

Direct Control Touch to view the options for manual control of the instrument. Refer to
the section: Direct Control.

Additional functions are available from the BioPhase 8800 driver
for Empower™. Refer to the section: Direct Control in the Waters
Empower™ Software.

Log Touch to view the front panel log. Refer to the section: Log.
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Direct Control
This section describes the Direct Control functions on the front panel of the BioPhase 8800
system.

Figure 3-5 Direct Control Window

Figure 3-6 Information
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Table 3-1 Direct Control Functions

Item Description

Touch to view or edit the temperature parameters. Refer to the
section: Set Temperature.

Touch to view or edit the wavelength settings parameters. Refer
to the section: Wavelength Settings.

Touch to eject the sample plates. Refer to the section: Load or
Eject Plates.

Touch to eject the reagent plates. Refer to the section: Load or
Eject Plates.

Touch to move the reagent and sample plates to the home
position. Refer to the section: Transport Home.

Set Temperature
Use the Set Temperature section to adjust the temperature for the sample storage and the
capillary cartridge.

BioPhase 8800 System Front Panel
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Figure 3-7 Set Temperature

Label Description

< Back Touch to return to the Direct Control window.

Sample Storage
Temperature

Touch to set the temperature value from 4 °C to 37 °C. The
actual temperature is shown in °C on the right.

Capillary Cartridge
Temperature

Touch to set the temperature value from 15 °C to 40 °C. The
actual temperature is shown in °C on the right.

Accept Touch to accept all the changes.

Wavelength Settings
Use the Wavelength Settings section to set the UV and LIF filter wavelength. The user can also
replace the UV lamp, UV filter, and LIF filter.
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Figure 3-8 UV Wavelength

Label Description

< Back Touch to return to the Direct Control window.

UV Filter 1

Filter Wavelength Touch to set the filter wavelength value, from 200 nm to 400 nm.

Serial Number Touch to set the serial number.

UV Filter 2

Filter Wavelength Touch to set the wavelength value, from 200 nm to 400 nm.

Serial Number Touch to set the serial number.

Done After completing the operation, touch Done to return to the
Direct Control window.

Replace Filter Refer to the section: Install a UV Filter.

Replace UV Lamp Refer to the section: Install a UV Lamp.

BioPhase 8800 System Front Panel
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Figure 3-9 LIF Wavelength

Label Description

< Back Touch to return to the Direct Control window.

Excitation Wavelength

Wavelength The wavelength is obtained from the laser on the system.

Emission Wavelength

Filter Wavelength Touch to set the wavelength from 300 nm to 700 nm.

Serial Number Touch to set the serial number.

Done After completing the operation, touch Done to return to the
Direct Control window.

Replace Filter Refer to the section: Install the LIF Detector Filters.

Load or Eject Plates
From the Direct Control window, the user can load or eject the sample and reagent plates.
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Figure 3-10 Load or Eject the Plates

Label Description

Eject/Load Reagent Touch to load or eject the reagent plate.

Eject/Load Sample Touch to load or eject the sample plate.

Note: The icon shows a down arrow when no plate is installed, and changes automatically to an
up arrow when a plate is installed.

Transport Home
Use the Transport Home buttton to move the reagent and sample plates to the home position.
Touch Transport Home to move the reagent plate to the home position (Column 1) and the
sample plate to the storage position.

BioPhase 8800 System Front Panel

BioPhase 8800 System For BioPhase 8800 Driver for
Empower™ Users
40/116

Operator Guide
RUO-IDV-05-15014-A



Figure 3-11 Reagent Tray Location

Log
This section describes the front panel log functions.
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Figure 3-12 Front Panel Events Tab

Label Description

Initialize System Touch to initialize the front panel system.

Note: The front panel status area shows a red exclamation icon
if an error occurs during the run. To re-initialize the system,
touch Initialize System.

Touch to remove the log message.
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Figure 3-13 Front Panel System Tab

Configure the System for the BioPhase 8800
Driver for Empower™

By default, the BioPhase 8800 system is configured for use with the BioPhase software. Use the
following steps to configure the system for the BioPhase 8800 Driver for Empower™.

Note: The username and passcodes given below are the defaults. They might have been
changed.

1. On the BioPhase 8800 system front panel, in the Login dialog:

a. In the Username field, type admin.

b. In the Passcode field, type password.

c. Touch Log In.

2. Touch Configuration.

3. Touch Network.

4. In Project Management section, do the following.

a. Select the Enable Third-Party Control check box.

b. In the Third-Party Control list, select Empower.

c. Touch Save.

5. In the BioPhase 8800 section, do the following.
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a. In the IP Address field, type the IP address for the system.
Use the same IP address used when configuring a node in the Waters Empower™

software. Refer to the section: "Configure the Node" in the document: Release Notes.

b. In the Subnet Mask field, type 255.255.255.0.

c. Touch Save.

Figure 3-14 Network Settings for the BioPhase 8800 Driver for Empower™

6. Turn off, and then turn on the BioPhase 8800 system.

a. In the top left corner of the touchscreen, touch the system icon.

Figure 3-15 BioPhase 8800 System Icon

b. Touch Power Off.

c. Press the power button on the front of the system.
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Direct Control in the Waters
Empower™ Software 4
Direct Control Status and Buttons
The status panel at the bottom of the Direct Control pane shows the system information and
status.

Figure 4-1 BioPhase 8800 Driver for Empower™ Direct Control Pane

Figure 4-2 Direct Control Status Pane

Item Description

Status Icons

Shows the sample storage temperature.

Direct Control in the Waters Empower™ Software

Operator Guide
RUO-IDV-05-15014-A

BioPhase 8800 System For BioPhase 8800 Driver for
Empower™ Users

45/116



Item Description

Shows the cartridge temperature.

Shows the pressure.

Shows the voltage of the capillaries.

Shows the current of the capillaries.

Shows the detector type.

Shows the coolant level.

Note: Green indicates an acceptable level, yellow indicates a low level,
and red indicates that the coolant is empty. The system will not operate if
the icon is red.

Buttons

Click to open the Trace View window.

Click to move the reagent and sample plates to the home position.

Click to stop any direct control function.

Note: This button does not stop a run. To stop a run, in the Run Samples

window, click  (Abort).
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Direct Control: System Status Tab
Figure 4-3 System Status Tab

Label Description

Cartridge

Status Shows the status of the cartridge.

Type Shows the type of cartridge.

Load or Eject Click to lock or eject the cartridge.

Transport

Sample Plate Shows the location of the sample plates.

Load or Eject Click to load or eject the sample plates.

Reagent Plate Shows the location of the reagent plates.

Load or Eject Click to load or eject the reagent plates.

Light Source

UV Lamp Shows the status of the UV lamp.

Turn On or Turn Off Click to turn the lamp on or off.
Note: After the lamp is turned on, a timer counts down from 30
minutes, indicating the time remaining before the lamp is ready.

LIF Laser If the system has an LIF detector installed, shows the status of
the laser.
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Label Description

Turn On or Turn Off Click to turn the laser on or off.
Note: After the laser is turned on, a timer counts down from 15
minutes, indicating the time remaining before the lamp is ready.
The LIF laser button is unavailable if the LIF detection system is
not installed on the instrument.

System Status Shows information about the system status.

Action Progress Status When a sample set method is running, shows the current
action in the instrument method, the elapsed time, and other
information about the action.

Method When a sample set method is running, shows the name of the
instrument method.

Direct Control: Rinse Tab
Figure 4-4 Rinse Tab

Label Description

Pressure (psi) Type the pressure value in psi.

Duration (minutes) Type the duration of the rinse in minutes.

Plate Click the plate that contains the rinse solution. The options are
Sample and Reagent.
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Label Description

Column Click the column that contains the rinse solution. The options
are 1 to 12.

Accept Click to start the rinse action.

Direct Control: Inject Tab
Figure 4-5 Inject Tab

Label Description

VOLTAGE Click to select a voltage injection.

Voltage (kV) Type the voltage for the injection in kV.

Duration (seconds) Type the duration of the injection in seconds.

Polarity Click the polarity of the voltage. The options are Normal and
Reverse.

Note: If PRESSURE is selected for the injection, then Polarity
is not enabled.

Plate Click the plate that contains the sample to be injected. The
options are Sample and Reagent.

Direct Control in the Waters Empower™ Software
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Label Description

Column Click the column that contains the sample to be injected. The
options are 1 to 12.

PRESSURE Click to select a pressure injection.

Pressure (psi) Type the pressure for the injection in psi.

Accept Click to start the injection.

Direct Control: Separate Tab
Figure 4-6 Separate Tab

Label Description

Voltage (kV) Type the voltage in kV.

Duration (minutes) Type the duration of the separation in minutes.

Ramp Time (minutes) Type the ramp time in minutes.

Polarity Click the polarity of the voltage. Options are Normal and
Reverse.
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Label Description

Plate Click the plate containing the solution for the separation.
Options are Sample and Reagent.

Note: If With Pressure is cleared, then this option is not
available.

Column Click the column containing the solution for the separation. The
options are 1 to 12.

Accept Click to start the separation.

With Pressure Select to apply pressure to the capillary while voltage is applied.

Pressure (psi) Type the pressure in psi.

Note: If With Pressure is cleared, then this option is not
available.

Direction Touch to select the direction for the pressure. Options are
Forward and Both.

Note: If With Pressure is cleared, then this option is not
available.

Direct Control: Temperature Tab
Figure 4-7 Temperature Tab
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Label Description

Sample Storage Temperature

Set to: Type the temperature for the sample storage compartment in
degrees Celsius.

Capillary Cartridge Temperature

Set to: Type the temperature for the capillary cartridge in degrees
Celsius.

Direct Control: Direct Settings Tab
Figure 4-8 Direct Settings Tab

Label Description

Maximum current limit (μA) Type the current limit in μA. The maximum current for all
capillaries is 600 μA.

Data Collection Rate (Hz) Select the data collection rate, in Hz, from the list. For UV
detection, the options are 1, 2, 4, and 8. For LIF detection, the
options are 2, 4, 8, and 10.

Note: Use a lower data collection rate to decrease the baseline
noise. Use a higher data collection rate if there are not enough
points to accurately identify the peak.

Peak Width @ 50% Height Type the estimated full width at half maximum (FWHM), in
seconds, for the narrowest peaks expected.
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Label Description

PMT Gain Select the value for PMT gain from the list. The options are 5,
10, 100, and 1000.

Note: Use lower values if the sample is expected to have high
intensity fluorescence. If the sample is expected to have low
intensity fluorescence, then use higher values.

Direct Control: Cartridge Info Tab
Figure 4-9 Cartridge Info Tab

Label Description

Serial Number Shows the cartridge serial number.

Lot Number Shows the cartridge lot number.

Capillary Type Shows the type of capillary.

Capillary Total Length Shows the total length of the capillary in cm.

Capillary Length to
Detector

Shows the length of the capillary to the detector in cm.

Capillary Internal Diameter Shows the diameter of the capillary to the detector in µm.

Recorded Number of Runs Shows the recorded number of runs.
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Label Description

First Use Date Shows the first date that the cartridge was used.

Expiration Date Shows the cartridge expiration date.

Direct Control: Wavelength Settings Tab
Figure 4-10 Wavelength Settings Tab

Label Description

UV Lamp

Filter 1 Wavelength Shows the wavelength of the first filter in nm.

Filter 2 Wavelength Shows the wavelength of the second filter in nm.

Cumulative Use Shows the number of hours the lamp has been in use.

LIF Laser

Excitation Wavelength Shows the excitation wavelength in nm.

Emission Wavelength Shows the emission wavelength in nm.

Cumulative Use Shows the number of hours the laser has been in use.

Direct Control in the Waters Empower™ Software
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Acquire Data 5
Data acquisition is started from the Waters Empower™ software.

Add a Reagent Set
1. In the Waters Empower™ Software Project window, click BioPhase 8800 > BioPhase

Instrument Method Editor.

The Method Editors for BioPhase System software opens, with the Instrument Method
Editor workspace shown.

2. On the ribbon, click , and then click Reagent Editor.
The reagent editor opens with the Reagent Set Configuration tab shown.

3. To add a new reagent to either of the reagent tables, click .
A new row shows in the table.

4. In the Name column of the new row, type a name for the new reagent.

5. In the Viscosity column of the new row, type the viscosity of the new reagent.
The default viscosity is 0.89 centipoise.

Note: To show a tooltip with a list of common viscosity values, hover the mouse over a
viscosity value.

6. Click the Color column, and then select a color from the list.

Tip! Select the color of the kit reagent cap.

7. For each additional reagent in the set, repeat steps 3 through 6.

8. (Optional) Click  to delete a reagent from the table.

9. (Optional) Click  to restore a deleted reagent to the table.

10. If the Validation pane is shown, then click the pane to view the errors. Click an error to
highlight the location where it occurs, and then make the required change.
If no errors are present, then the Validation pane is not shown.

11. Save the reagent set.

a. Click SAVE AS.
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Note: The SAVE AS button is not available if there are errors. Resolve all of the errors
in the Validation pane, and then click SAVE AS.

b. If the same color is assigned to different reagents, then a message is shown. If the
colors should be the same, then click Yes.
This message occurs when the same reagent, such as water, has different names such
as "Water Dip 1" and "Water Dip 2".
The Save Reagent Set dialog opens.

c. Type a name in the Reagent Set field.

d. Click Save, and then click OK to acknowledge the saved reagent set.

Create a New Instrument Method
Instrument methods can also be created by importing a BioPhase software method. Refer to the
section: Import a BioPhase Software Method to Create an Instrument Method.

1. In the Waters Empower™ Software Project window, click BioPhase 8800 > BioPhase
Method Editor.
The Method Editors for BioPhase System software opens, with the Instrument Method
Editor workspace shown.

2. Click New Instrument Method.
The Instrument Method Editor opens with the Method Settings tab in front.

3. Click the Reagent Set list and select the reagent set.
The Inlet Reagents from Reagent Set and Outlet Reagents from Reagent Set tables are
populated.

4. Type or select information in the Method Settings fields.

5. To build the method, open the Method Program tab, and then drag actions to the Program
pane.

Three types of methods can be created:

• Separation method: A method with an Inject action, which is used to acquire the data for
the sample.

• Conditioning method: A method without an Inject action, which is used to condition the
capillary before running a separation method to acquire data.

• Shutdown method: A method without an Inject action, which is used to clean the capillary
to preserve the life span of the cartridge and turn off the light source.

Tip! To add an action to the end of the method, double-click the action. Use the right-click
menu to copy, paste, or delete actions from the Program pane.
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Figure 5-1 Action and Program Panes

6. Click the actions in the Program pane to edit the action parameters in the Parameters pane.
If required, additional reagents can be added to the Inlet Reagents from Reagent Set and
Outlet Reagents from Reagent Set tables on the Method Settings tab.

Note: Any changes are not saved to the reagent set. If the new reagents are to be used
later, create a new reagent set. Refer to the section: Add a Reagent Set.

7. To edit the locations of the reagents in the reagent plates, do the following:

a. Open the Reagent Plate Setup tab.

b. Click Column for the reagent and then select the column from the list.
Each column can only be assigned one reagent.

8. If the Validation pane is shown, then click the pane to view the errors. Click an error to
highlight the location where it occurs, and then make the required change.
If no errors are present, then the Validation pane is not shown.

9. Save the method:

a. Click SAVE AS.

Note: The SAVE AS button is not available if there are errors. Resolve all of the errors
in the Validation pane, and then click SAVE AS.

The Save Instrument Method dialog opens.

b. Type a name in the Method Name field.

Note: The method name must be unique to enable the Save button.

c. (Optional) Type a description for the method in the Description field.

d. Click Save and then click OK to acknowledge the saved method.

The method is saved to the Waters Empower™ software database.
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10. In the Method Editors for BioPhase System window, click the close box, the × in the top right
corner.
The Method Editors for BioPhase System software closes and the Project window is shown.

To use the instrument method in the Waters Empower™ software, make sure to add the method
to a method set. Refer to the section: Create a Method Set.

Import a BioPhase Software Method to Create an
Instrument Method
Use the following steps to import a BioPhase software method and create an instrument method
that can be used with the Waters Empower™ software.

1. In the Waters Empower™ Software Project window, click File > New Method > Instrument
Method.

Figure 5-2 Select Desired Chromatography System Dialog

2. Click the system to be used, and then click OK.
The Instrument Method Editor opens.

3. Click Import, and then browse to the conditioning method.
The method opens in the Instrument Method Editor window with the Method Settings tab in
front.

Note: This window is read-only. If changes to the method are required, then save the
instrument method, and then edit the method in the Method Editors for BioPhase System
software. Refer to the section: "Edit an Existing Instrument Method" in the document:
Software Help.
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Figure 5-3 Method Settings Tab in the Instrument Method Editor

4. (Optional) Open the Method Program tab to see the actions.

5. To see the parameters for an action, click the row in the table.
The Parameters pane updates to show the parameters.
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Figure 5-4 Method Program Tab in the Instrument Method Editor

6. Save the instrument method.

a. Click File > Save with Method Set.
The Save current Instrument Method dialog opens.

b. In the Name field, type a name.

Note: The name must be less than 30 characters and contain alphanumeric characters,
spaces, and the special characters @, _, and %. Although some versions of the Waters
Empower™ software accept more than 30 characters and other special characters, if
the method is edited in the Method Editors for BioPhase System software, then those
characters might cause issues.

c. (Optional) Click the Method Comments field and then type the information.

d. If prompted, in the Password field, type the Waters Empower™ software password for
the current user, and then click Save.

The instrument method and the method set are saved to the current project.

7. Click File > Exit.

Note: After a method has been imported, the Import button in the Instrument Method Editor
window is not available unless the window is closed and then opened.
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Create a Method Set
For each instrument method, a method set is required.

Note: A method set can also include processing, report, and export methods. To create those
methods, refer to the documentation supplied with the Waters Empower™ software.

1. In the Waters Empower™ Software Project window, click File > New Method > Method Set.

2. In the message, click No.
The Method Set Editor window opens.

3. In the Instrument Method list, select the instrument method. Do not make any other
changes.

Figure 5-5 Method Set Editor Window

4. Save the method set.

a. Click File > Save.

b. In the Name field, type a name for the method set.

c. (Optional) Type information in the Method Comments field.
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d. If prompted, in the Password field, type the Waters Empower™ software password for
the current user and then click Save.

Figure 5-6 Save current method set Dialog

The method set is saved to the current project.

Create the Sample Set Method
A sample set method is a list of samples and associated method sets that is sent to the
BioPhase 8800 system for data acquisition.

Note: A sample set method can also be created with the Waters Empower™ software, but only
the Method Editors for BioPhase System software can create the plate layouts and validate the
sample set method for use with the BioPhase 8800 system.

Create the Sample Set Method
Note: A sample set method requires method sets. Make sure that any required instrument
method is part of a method set.

The arrangement of the samples and method sets in the sample set method influences the
duration of data acquisition. Refer to the section: Tips for Setting Up the Sample Set Method.
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1. In the Waters Empower™ Software Run Samples window, click BioPhase 8800 > BioPhase
Sample Set Editor.

The Method Editors for BioPhase System software opens, with the Sample Set Method
Editor workspace shown.

2. Click New Sample Set Method.
The Sample Set Method Editor opens with the Sample Plate Setup tab shown.

3. In first row of the Sample Set Summary table, click the Method Set Name cell and then
select the appropriate conditioning method.

4. In the Sample Plate Layout pane, select the wells where the sample will be added.

• Click an individual well.

• To select all of the wells in a column, click the column number.

Figure 5-7 Sample Plate Layout Pane

The Sample Plate Layout updates to show the selected wells.

5. If required, to delete a well from the sample set method, right-click the row in the Sample
Set Summary table and then select Delete Row.
To delete all wells, click NEW and then create a new sample set method.

6. Add the required sample information to the Sample Set Summary table. In the rows with
samples, do the following:
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Tip! The required information can also be added by pasting information copied from Excel.
Click the Plate/Well cell and then press Ctrl-V to paste information from Excel. The copied
text should contain the well, the sample name, and the method set name. If the method set
is not present in the Empower database, then the method set cell in the sample set table is
blank after pasting.

a. In the Sample Name cell, type a name for the sample.

b. Click the Method Set Name cell, and then select the appropriate separation method
from the list.

Tip! Select the method for the first sample row, and then right-click and select Apply
method to all samples in column to assign the method to all of the samples in the
column.

7. Repeat the previous step until all of the samples have been assigned a method set.

8. Click the Sample Set Method cell in the last row and select the appropriate shutdown
method.

Figure 5-8 Sample Set Summary Table

9. If the Validation pane is shown, then click the pane to view the errors. Click an error to
highlight the location where it occurs, and then make the required change.
If no errors are present, then the Validation pane is not shown.

10. Save the sample set method.

a. Click SAVE AS.

Note: The SAVE AS button is not available if there are errors. Resolve all of the errors
in the Validation pane, and then click SAVE AS.

The Save Sample Set dialog opens.
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b. Type a name in the Sample Set Name field.

Note: The name must be less than 30 characters and contain alphanumeric characters,
spaces, and the special characters @, _, and %. Although some versions of the Waters
Empower™ software accept more than 30 characters and other special characters, if
the method is edited in the Method Editors for BioPhase System software, then those
characters might cause issues.

c. (Optional) Type information in the Description field.

d. Click Save, and then click OK to acknowledge the saved method.

The sample set method is saved to the Waters Empower™ software database.

11. To view, save, or print the plate layouts:

a. Open the Plate Layouts tab.

b. (Optional) Click PRINT.
The Print Preview window opens.

c. As required, click the buttons to print or save the plate layouts.
Refer to the section: "Print Preview Dialog" in the document: Software Help System.

d. Click the close box, the × in the top right corner.
The Print Preview dialog closes.

12. In the Method Editors for BioPhase System window, click the close box, the × in the top right
corner.
The Method Editors for BioPhase System software closes and the Run Samples window is
shown.

Tips for Setting Up the Sample Set Method
The order of the samples in the sample set method influences the number of runs and thus the
required time. The BioPhase 8800 system is designed to acquire data from all eight capillaries at
the same time, regardless of the method set that is assigned to each well. If a different method
set is assigned to each well in a column, then there will be eight separate runs.

Use the following recommendations to minimize the time required to run a sample set method.

• To prevent starting a new run, group samples that have the same method set in the same
column (or columns). If more than one method set is in use, then put the samples using the
same method set in adjacent wells.

• To minimize the required sample volume, do not assign more than one method set per
column.

What Causes a New Run
A new run occurs if the current sample well:
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• Is in a different column on the plate.

• Is the same well as the previous run.

• Is before the well in the previous run. For instance, the previous sample well was D1 and the
current sample well is A1.

• Has a different method set than the previous run

The following example illustrates how the software determines when to initiate another run. It
assumes that well A1 is the first well in the sample set method.

1. After any conditioning, the sample set method instructs the BioPhase 8800 system to inject
sample from all eight wells in column 1 (well A1 through well H1), and then uses the method
set assigned to well A1 to acquire data.

2. The software saves the data for well A1 and holds the data for wells B1 to H1 in memory.

3. The software evaluates the next row in the sample set method.

• If the well is B1 and the method set is:

• The same as for A1, then the data for well B1 is saved and then the software
evaluates the next row in the sample set method. This step is repeated until either
data for the entire column is saved, or the next well contains a different method set.

• Different than for A1, then the data in memory is deleted, and a new run is started.
Sample is injected from all eight wells in column 1.

• If the well is not B1:

• If the well is A1 (a replicate), then the data in memory is deleted, and a new run is
started. Sample is injected from all eight wells in column 1.

• If the well is in column 1 and the method set is:

• The same as for A1, then the data in memory is saved and the software evaluates
the next row in the sample set method.

• Different than for A1, then the data in memory is deleted, and a new run is started.
Sample is injected from all eight wells in column 1.

• If the well is not in column 1, the data in memory is deleted, and then a new run is
started. Sample is injected from all eight wells in the column where the well is located.

4. After the run is complete, the software saves the data for the current well. Then it evaluates
the next row in the sample set method as described previously, except that the well is the
next well in the column, not B1. Refer to step: 3.

Prepare the BioPhase 8800 System
Use the procedures in this section to prepare the BioPhase 8800 system to acquire data.
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The procedures in this section assume that the system has already been properly installed and
initialized.

Tip! To save time, turn on the light source 30 minutes before starting the run so it can warm up.

Load the Reagent Inlet and Outlet Plates
Note: To prevent air bubbles, do not shake or vigorously mix the buffer. Air bubbles might cause
issues with the separation.

1. Add the reagents to the reagent inlet and outlet plates according to the reagent plate layout.

Use the volumes in the following table.

Note: For the outlet plate, make sure that the chamfered corner is on the upper right, and
then fill only the wells on the left side of the plate. The wells on the right side are for overflow
and must be empty.

Table 5-1 Reagents for the Reagent Inlet and Outlet Plates

Plate Reagent

Inlet plate 800 µL per well

Outlet plate • 2.8 mL per well of reagent for separation or wait actions

• 1.5 mL per well of CE Grade Water for waste positions

2. Put a film cover on the plates.

CAUTION: Potential System Damage. Do not use a heated plate sealer to apply the
seal. The heat might damage the surface of the plates, which might cause issues with
the pressure system.

Note: Only X-Pierce film from USA Scientific is validated. If a different film is used, then test
it before use.

3. Put the plates in a swinging-bucket rotor, and then spin them for 4 min at 30 g. Make sure
that the buckets are balanced.

CAUTION: Potential Wrong Result. Do not load the plates in the system without
spinning them to remove air bubbles. The presence of air bubbles might cause the
separation to fail.

4. Make sure that there are no air bubbles present in the plates. If air bubbles are present,
then spin the plates again at a higher relative centrifugal force (RCF).

Acquire Data

Operator Guide
RUO-IDV-05-15014-A

BioPhase 8800 System For BioPhase 8800 Driver for
Empower™ Users

67/116



For the reagent plate, the maximum RCF is 1,000 g. For the sample plate, the maximum
RCF is 375 g.

5. On the front panel, touch Eject Reagent.

Figure 5-9 Eject Reagent Button

The plate compartment opens.

6. Remove the film cover from the plates.

CAUTION: Potential System Damage. Do not load plates in the system before
removing the film cover. The presence of the film cover during a run might damage
the capillary tips.

7. If the plate compartment already contains reagent plates, then remove the reagent plates.

8. Align the notch in the reagent inlet plate with the tab, and then put the plate in the plate
carrier. Refer to the figure: Figure 2-6.

9. Make sure that the chamfered corner of the reagent outlet plate is in the top left, and then
put the plate in the back of the plate carrier. Refer to the figure: Figure 2-7.

10. Touch Load Reagent.

Figure 5-10 Load Reagent Button

The plate compartment closes.

Load the Sample Inlet and Outlet Plates
1. Add the samples to the sample inlet plate according to the sample plate layout.

The minimum sample volume is 50 µL. The maximum sample volume is 200 µL.

The recommended sample volume varies by application. Refer to the specific Application
Guide.

2. To prevent damage to the capillary, if there are columns where not every well has sample,
then add between 100 µL and 200 μL of sample buffer to each empty well.
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If a column has no samples, then the wells can be left empty.

3. Add the reagents to the sample outlet plate according to the sample plate layout.
The maximum volume is 2.0 mL.

The recommended volume varies by application. Refer to the specific Application Guide.

Note: For the outlet plate, make sure that the chamfered corner is on the upper right, and
then fill only the wells on the left side of the plate. The wells on the right side are for overflow
and must be empty.

4. Put a film cover on the plates.

CAUTION: Potential System Damage. Do not use a heated plate sealer to apply the
seal. The heat might damage the surface of the plates, which might cause issues with
the pressure system.

Note: Only X-Pierce film from USA Scientific is validated. If a different film is used, then test
it before use.

5. Put the plates in a swinging-bucket rotor, and then spin them for 4 min at 30 g. Make sure
that the buckets are balanced.

CAUTION: Potential Wrong Result. Do not load the plates in the system without
spinning them to remove air bubbles. The presence of air bubbles might cause the
separation to fail.

6. Make sure that there are no air bubbles present in the plates. If air bubbles are present,
then spin the plates again at a higher relative centrifugal force (RCF).
For the reagent plate, the maximum RCF is 1,000 g. For the sample plate, the maximum
RCF is 375 g.

7. On the front panel, touch Eject Sample.

Figure 5-11 Eject Sample Button

The plate compartment opens.

8. Remove the film cover from the plates.
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CAUTION: Potential System Damage. Do not load plates in the system before
removing the film cover. The presence of the film cover during a run might damage
the capillary tips.

9. If the plate compartment already contains sample plates, then remove the sample plates.

10. Orient the sample plate so that the alignment notch in the plate aligns with the tab, and then
put the plate in the plate carrier. Refer to the figure: Figure 2-5.

11. Orient the sample outlet plate so that the chamfered corner is in the upper left, and then put
the plate in the back of the plate carrier. Refer to the figure: Figure 2-7.

12. Touch Load Sample.

Figure 5-12 Load Sample Button

The plate compartment closes.

Examine the Capillary Cartridge
WARNING! Puncture Hazard. Be careful when handling the cartridge. The tips of
the capillaries are extremely sharp.

CAUTION: Potential System Damage. Do not let the separation gel or other reagents
crystallize on the electrodes, capillary ends, cartridge seals, or cartridge body. Electrolyte
salt crystals or precipitate can cause plugged capillaries, improper pressure sealing,
errors when injecting samples, arcing, or current leakage.

1. Examine the electrodes, capillary tips, cartridge seals, and cartridge body interface before
use.

2. If there is liquid on the outside of the cartridge, then clean the cartridge with a damp lint-free
laboratory wipe. After cleaning, make sure to dry the cartridge.

Note: Do not use soap or detergent to clean the cartridge.

3. If the capillary tips are blocked, then do this:

a. Use CE Grade Water to clean the capillary inlets.

b. Use a lint-free laboratory wipe to wipe the capillary inlets carefully in an outward
direction.
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4. Use a magnifying glass to examine both sides of the capillary window. If lint or other
particles are present, then use short bursts of electronics-grade compressed air to remove
them. Do not use water or other liquids to clean the capillary window.

CAUTION: Potential System Damage. Do not use organic solvents, such as methanol
or acetone, to clean the capillary window. Organic solvents can dissolve the
adhesives, leaving residue on the capillary window that might interfere with the
detector.

5. Moisten a lint-free laboratory wipe or cotton swab with ethanol or isopropyl alcohol, and then
wipe the surface of the chip. Let the chip air dry before installing the cartridge.

Install the Cartridge
WARNING! Puncture Hazard. Be careful when handling the cartridge. The tips of
the capillaries are extremely sharp.

WARNING! Pinching Hazard. When opening the front panel, be careful not to put
fingers to the left of the front panel.

CAUTION: Potential System Damage. Make sure that the reagent plates are installed in
the system before installing the cartridge. Failure to do so might damage the cartridge.

1. If the cartridge was stored in the refrigerator, then let the cartridge equilibrate to room
temperature for approximately 30 min to prevent condensation in the system.

2. Remove the cartridge from the wetting tray.

3. Use a disposable laboratory wipe to dry the cartridge body to prevent arcing.

4. Turn the bottom of the cartridge up.

5. Use a disposable lint-free laboratory wipe to very gently dry the area where the capillaries
and electrodes emerge from the cartridge. Do not disturb the seals.
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Figure 5-13 Bottom of the Cartridge

Item Description

1 Outlet plate seal

2 Inlet plate seal

6. If the reagent plates are not installed in the system, then install them. Refer to the section:
Load the Reagent Inlet and Outlet Plates.

7. Open the front panel, and then put the cartridge in the system.

8. Close the front panel, and then touch EJECTED to lock the cartridge.

Figure 5-14 EJECTED Button
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If the cartridge run life has been exceeded, then a warning message is added to the front

panel log. To view the warning message, touch  on the front panel status area. The
cartridge can still be used or a new one can be installed.

The system moves the reagent plate so that the capillaries are in position over column 1,
and then raises the plate so that the capillary ends are immersed in CE Grade Water.

9. Examine the coolant level on the front panel. If required, add coolant into the fill port on the
system.
Refer to the section: Add Capillary Cartridge Coolant.

Start the Sample Set Method
1. Load the cartridge and the plates. Refer to the section: Prepare the BioPhase 8800 System.

2. In the Waters Empower™ software Project window, click Tools > Run Samples.

Figure 5-15 Select Desired Chromatography System Dialog

3. Click the system to be used, and then click OK.
The Run Samples window opens.

4. Configure the plate type.

a. Click Edit > Plates.
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Figure 5-16 Define Plates for Sample Set Method Dialog

Note: If the dialog does not look like the preceding figure, then clear the 2790 Layout
check box.

b. Click the Plate Type Name cell, and then select ANSI-96well2mL.
The dialog updates with an image of the plate and buttons for the plate sequencing
mode.

c. Click the Plate Layout Position cell, and then type 1.

d. Click  to indicate the order in which the wells are accessed during the run.

e. Click OK to save the changes, and then close the dialog.

Tip! To permanently configure the plate type, click Customize > Defaults, click Plates, do
steps 4.b through 4.e, and then click OK.

In the Sample Set Method table, the heading for the Vials column changes to Plate/Well.

5. Click  (Load Sample Set).
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Figure 5-17 Load Samples Dialog

6. Click Load using a previously created sample set method, and then click OK.

Figure 5-18 Open an existing sample set method Dialog

7. Click the sample set method in the list, and then click Open.
The sample set method opens in the Samples tab.

8. (Optional) Configure the table to show only the columns that are relevant for the BioPhase
8800 system.
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a. Right-click, and then select Table Properties.
The Table Properties dialog opens.

b. Click Hide All, and then clear the check boxes for Plate/Well, # of Injs, SampleName,
Function, and Method Set / Report or Export Method.

c. Click OK.

The table updates to show the selected columns.

Figure 5-19 Samples Tab

9. Review the sample set method. If any changes are required, then edit the method in the
Method Editors for BioPhase System software. Any changes to the instrument methods or
method sets automatically propagate to the sample set method.

10. In the Waters Empower™ Software Project window, click  (Start).
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Figure 5-20 Run Sample Set Dialog

11. If required, edit the information in the Run Sample Set dialog.

a. If required, edit the Name for this sample set field.

b. Click Shutdown Method, and then select an instrument method which rinses the
capillaries.

Note: For the rinse solution, make sure to use a solution that is compatible with the
capillaries in use.

If the system encounters an error during a run, then it executes this instrument method,
and then stops the run.

c. If required, select Do Not Run Shutdown Method During User Abort.

d. Click Run.

The run starts. During the run, the text in the row in the Sample Set Method window for the
sample being acquired is red.
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CAUTION: Potential Data Loss. Do not initiate any actions from the BioPhase 8800
driver for Empower™ Direct Control pane during a run, even if the system status is
idle. Any actions might interfere with data acquisition.

Monitor the Run in the Waters Empower™

Software
Use this procedure to monitor the progress of the sample set method, and then, if required,
pause or stop it.

Note: Most of the panes in the Waters Empower™ software are designed for chromatography.
Use the following steps to monitor the progress of the capillary electrophoresis separation and
disregard information in the Time Remaining and Solvent Required panes.

1. If a problem is detected, to stop the run, click  (Abort).

CAUTION: Potential Data Loss. Do not stop the run until all of the data is saved. The
data is saved when the sample set method is on the next row.

Note: Do not use the Stop button in the Direct Control pane. That button only operates on
functions initiated from the Direct Control pane.

Figure 5-21 Abort Options Dialog
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CAUTION: Potential System Damage. If the run is stopped, then use the conditioning
method to rinse the capillaries before using the cartridge again. If the capillaries
are not rinsed, electrolyte salt crystals or precipitate can accumulate and might
cause plugged capillaries, improper pressure sealing, errors when injecting samples,
arcing, or current leakage.

When the run ends, the text in all of the rows in the Sample Set Method window is red.

2. To view the data while it is acquired, in the Direct Control pane, click  (Monitor).
The Trace View window opens, and then the data is shown.

Figure 5-22 Trace View Window

3. If required, do any of the following:

• To view current, voltage, or pressure, open the applicable tab in the top left.

• To view one graph with the data for all of the capillaries, in the bottom left click Overlay.

• To view data for specific capillaries, select or clear the check boxes at the bottom of the
window to select the capillaries of interest.
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• To view the time and detector values for any point on a trace, click the trace at the
position of interest.

• To zoom in on the data, make sure that Overlay is selected, and then drag to select the
area to zoom. The mouse scroll wheel can also be used to zoom.

• To return the data to the original dimensions, in the bottom right click Reset Zoom.

• To view a different area of a zoomed plot, right-click the X- or Y-axis and then drag.

4. If required, at the bottom right click Auto Zero.
The detector signal is set to zero.

5. Wait until the Abort button ( ) changes from red to green ( ).
There might be a delay between data acquisition and when all of the data is saved. The
green button indicates when all of the data is saved.

6. As required, dispose of samples and reagents. Refer to the section: "Waste Disposal" in the
document: Application Guide.

7. As required, store the cartridge. Refer to the section: Store the Cartridge After the Run.

Store the Cartridge After the Run
WARNING! Puncture Hazard. Be careful when handling the cartridge. The tips of
the capillaries are extremely sharp.

Store the Cartridge for Less than Three Days
1. If the sample set method does not include a shutdown method, then use the shutdown

method to clean the capillary.

2. Store the cartridge for up to three days in the system with the capillary ends immersed in CE
Grade Water.

Note: If the cartridge has not been used for three hours or longer, then run the conditioning
method before doing a separation.

Store the Cartridge for More than Three Days
1. If the sequence or sample set method does not include a shutdown method, then use the

shutdown method to clean the capillary.

2. On the ribbon on the BioPhase 8800 system front panel, touch  (Loaded) and
then wait for about one minute.
Waiting lets the coolant return to the coolant reservoir before the cartridge is removed.
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3. Remove the cartridge from the system, and then store it upright in the cartridge box at 2 °C
to 8 °C with the capillary ends immersed in CE Grade Water.

Note: Replace the CE Grade Water in the tray regularly to avoid microbial growth in the tray.

Prepare the Cartridge After Storage
• If the cartridge has not been used for more than a day, or if it has been stored for an extended

time, then use the conditioning method to condition the capillary.

Note: To prevent arcing, and before installing the cartridge in the system, carefully wipe off any
water from around the electrodes and cartridge body.
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Maintenance 6
WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Identify whether decontamination is required before cleaning
or maintenance. If radioactive materials, biological agents, or toxic
chemicals have been used with the system, then the customer must
decontaminate the system before cleaning or maintenance.

Clean the Surfaces
Clean the external surfaces of the system after a spill or when they become dirty.

Required Materials

• Soft cloth

1. Use a soft, damp cloth to clean the surfaces of the system.

2. Use a soft, dry cloth to remove any moisture from the surfaces.

Add Capillary Cartridge Coolant
Required Materials

• Capillary cartridge coolant (PN 359976)

• Fill tool (PN 144647)

1. Examine the level of the coolant on the BioPhase 8800 system front panel.
If the cartridge coolant level is red, then add coolant.

2. Move the panel to the left to get access to the coolant fill port.

3. Attach the fill tool to the port.

4. Hold up the end of the syringe and slowly fill the syringe with coolant while monitoring the
indicator until the required fill level is reached.

5. Let the syringe drain.

6. Repeat steps 4and 5 until the cartridge coolant level is green.

Maintenance
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Figure 6-1 Coolant Fill Port

Item Description

1 Coolant fill port

Clean the Sample Lid and the Plate Compartment
Cover
Remove and examine the sample lid at regular intervals. If required, then clean the sample lid
and plate compartment cover.
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Required Materials

• Wet cloth

• Dry cloth

• (Optional) Laboratory tissues

1. On the front panel, touch Eject Sample or Eject Reagent.
The plate compartment cover opens automatically to show the plate compartment.

Figure 6-2 Plate Compartment Open

2. If plates are installed, then remove them.

3. Remove the plate compartment cover and sample lid.

a. Press down on the notch at the front of the white plate compartment cover to dislodge it
from the blue sliding door.

b. Pull the plate compartment cover far enough forward to remove it.

The sample lid rests in the plate compartment cover.
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Figure 6-3 Plate Compartment Cover Partially Forward, Notch Circled in Red

Figure 6-4 Sample Lid, Top, and Plate Compartment Cover, Bottom

4. Use a wet cloth or laboratory tissue to clean the bottom of the sample lid and the plate
compartment cover.

5. Install the sample lid on the plate compartment cover, and then install the lid and cover in
the slot in the plate compartment. Push the lid and cover in until they click in place.

Figure 6-5 Slot in Plate Compartment, Circled in Red
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6. Install the plates that were removed in step 1.

7. On the front panel, touch Load Sample or Load Reagent.

Install a UV Filter
The UV detector is supplied with two filters: 220 nm and 280 nm. If a different filter is necessary,
one or both of the filters can be replaced. Refer to the table: Table 7-1.

Required Materials

• Filter

• Powder-free gloves

1. On the front panel, do the following:

a. Touch Direct Control to open the Direct Control window.

b. Touch Wavelength Settings.

Figure 6-6 Wavelength Settings Button

c. Touch Replace Filter to replace the filter. The Replace Filter button is unavailable if
UV Filter 1 and UV Filter 2 values are not entered.
The touchscreen updates to show an image and instructions.
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Figure 6-7 Access Door for the Optics Compartment

2. On the system, push in the lower left corner to unlock and pull open the access door for the
optics compartment.
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Figure 6-8 Opening the Access Door for the Optics Compartment

CAUTION: Potential Data Loss. Do not open the access door for the optics
compartment during a run. If the door opens, then the voltage system and light
source turn off and the separation might be compromised.

3. Remove the round cover and the filter assembly.

4. Turn the thumbscrew counterclockwise to loosen it, and then remove the filter assembly.
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Figure 6-9 UV Filter Assembly

Item Description

1 UV filter 1

2 Thumbscrew

3 UV filter 2

5. Install the filter assembly.

6. Turn the thumbscrew clockwise to tighten it.

7. Install the round cover.

8. Close the access door for the optics compartment.

9. On the front panel, touch Done.

10. On the front panel, update the filter information:

a. Type a UV wavelength and serial number for UV filter 1.

b. Type a UV wavelength and serial number for UV filter 2.

c. Touch Done.
The UV filter data has been changed successfully.
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Figure 6-10 UV Filter Assembly Saved Changes

Install a UV Lamp
The UV lamp is used by the UV detector. If the baseline is excessively noisy or the lamp will not
illuminate, it might be necessary to replace the lamp.

Required Materials

• UV lamp

• Powder-free gloves

WARNING! Hot Surface Hazard. Before replacing a lamp, allow sufficient time for
the lamp to cool thoroughly. A hot lamp will cause burns.

1. On the front panel, do the following:

a. Touch Direct Control to open the Direct Control screen.

b. Touch Wavelength Settings.
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Figure 6-11 Wavelength Settings Button

c. Touch Replace UV Lamp to replace the UV lamp.
A window opens with an image and instructions.

Figure 6-12 Access Door for the Optics Compartment

2. On the instrument, push in the lower left corner to unlock and pull open the access door for
the optics compartment.
A safety interlock turns off power to the lamp when the access door is opened.
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Figure 6-13 UV Lamp Replacement

Item Description

1 Lamp plug

2 Thumbscrew

3. Wait for the lamp to cool before removing it.

4. Press the side tabs of the connector to disconnect it from the panel.

5. Loosen the captive thumbscrews and press the connector latching tab.

6. Remove the lamp.

7. Install the new lamp, aligning the pin with the notch.

8. Tighten the captive thumbscrews.

9. Install the connector.

10. Close the access door for the optics compartment.
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A safety interlock turns on power to the lamp when the access door is closed.

11. On the front panel, touch Done.
The UV lamp has been changed successfully.

Figure 6-14 UV Lamp Changed

12. If required, touch the UV Lamp button on the ribbon.
The lamp turns on and the timer counts down to indicate the remaining time before the lamp
is ready.

Install the LIF Detector Filters
The LIF detector is supplied with two filters: a notch filter that blocks light at 488 nm and an
emission filter that transmits light at 520 nm. The filters are installed in a filter holder. If a new
filter is required, then the full filter holder must be purchased.

Required Materials

• Filter holder (PN 5066941)

• Powder-free gloves

1. On the front panel, do the following:
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a. Touch Direct Control to open the Direct Control screen.

b. Touch Wavelength Settings.

Figure 6-15 Wavelength Settings Button

c. Touch LIF Wavelength.

d. Touch Replace Filter.
A window opens with an image and instructions.

Figure 6-16 Access Door for the Optics Compartment
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2. On the instrument, push in the lower left corner to unlock and pull open the access door for
the optics compartment.
A safety interlock turns off power to the laser when the access door is opened.

CAUTION: Potential Data Loss. Do not open the access door for the optics
compartment during a run. If the door opens, then the voltage system and light
source turn off and the separation might be compromised.

Figure 6-17 Remove the LIF Filter Holder

3. Remove the filter and holder.

4. Install a new filter and holder.
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Figure 6-18 LIF Filter Holder

5. Touch Done.

6. On the front panel, update the LIF filter information:

a. Type a filter wavelength and serial number for the LIF emission filter.

b. Touch Done.
The LIF filter has been changed successfully.

Figure 6-19 LIF Wavelength
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Replace the Fuse
WARNING! Fire Hazard or Electrical Shock Hazard. Before replacing fuses,
turn off the system and disconnect it from the mains supply. Replace a
fuse only with a fuse of the correct type and rating. Failure to follow these
guidelines might result in fire, electric shock, or instrument malfunction.

Required Materials

• 10 A 250 V fuse, marked T10A250V

• Small, flat-bladed screwdriver

1. Turn off the system.

2. Disconnect the mains supply cable from the mains supply outlet and from the back of the
system.

3. Use a small flat-bladed screwdriver to remove the fuse holder located above the connector
for the mains supply cable.

4. Remove the fuse from the fuse-carrier assembly.

5. Install the fuse in the fuse-carrier assembly, and then install the assembly in the system.

6. Connect the mains supply cable to the back of the system and the mains supply outlet.

7. Turn on the system.

8. On the Windows desktop, open the BioPhase software and then log on to the software.

9. If the system does not operate normally, or if the fuse blows again, then contact sciex.com/
request-support.
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Order Parts 7
• Order parts from SCIEX in any of the following ways:

• Telephone: (877) 740-2129, Option 1 (toll-free, United States only), or go to sciex.com/
contact-us to find a local office.

• E-mail: Sales.Americas@sciex.com

• Fax: (800) 343-1346

• Internet: For customers in the United States, United Kingdom, and Germany order from
store.sciex.com.

Cartridges and Parts
Part Number Description

359976 Capillary cartridge coolant, 450 mL

5080311 BioPhase Chemistry Plate Kit (4 sample plates, 4 reagent plates,
8 outlet plates)

5080313 BioPhase sample plates (20 plates)

5080314 BioPhase reagent plates (20 plates)

5080315 BioPhase outlet plates (20 plates)

5080121 Cartridge, 8 capillaries, 30 cm long, 360 µm o.d., 50 µm i.d.,
bare-fused silica capillary

5080119 Cartridge, 8 capillaries, 30 cm long, 360 µm o.d., neutral capillary

Table 7-1 Filters

Part Number Description

5085153 UV filter assembly with 220 nm and 280 nm filters

5066890 UV filter, 220 nm

5072643 UV filter, 280 nm

5085159 LIF filter holder with 520 nm filter

5085178 LIF filter holder with 560 nm filter

Order Parts
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Table 7-1 Filters (continued)

Part Number Description

5085177 LIF filter holder with 600 nm filter

Table 7-2 Lamp

Part Number Description

5065163 Deuterium lamp

Order Parts
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System Specifications A

Instrument Specifications
Dimensions (H × W × D) 72 cm x 62 cm x 69 cm (28.2 in. × 24.4 in. × 27.2 in.)

Weight 90.9 kg (200 lb)

Electrical Power requirement: 100 VAC to 240 VAC, 10 A, 50 Hz or 60 Hz,
Class I

Power consumption: Supply voltage must not exceed 10% of
nominal

Fuses:

• T10 A

• 250 V

Installation (overvoltage) category: Category II

Working environment Altitude:  2,000 m (6,562 ft) above sea level

Humidity: < 70% (noncondensing) at 30 °C

Temperature: 15 °C to 30 °C (59 °F to 86 °F) recommended

Maximum heat dissipation 600 W (2,047 BTU/hr) under steady-state conditions

Maximum sound pressure 70 dB

Maximum pressure at 1 m: 66 dB

Detector Specifications
UV Detector Specifications
Table A-1 UV Detector Specifications

Available filters 220 nm and 280 nm

Filter bandwidth 25 nm nominal

System Specifications
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Table A-1 UV Detector Specifications (continued)

UV source 33 W pre-aligned deuterium lamp

UV source lifetime 1,000 hours

(Optional) LIF Detector Specifications

Table A-2 LIF Detector Specifications

Baseline drift < 0.2 RFU/hr

Baseline noise < 0.005 RFU peak to peak

Dynamic range (at a
setting of 1,000)

> 104

Default filters 488 nm notch filter (to block excitation wavelength) and 520 nm
bandpass filter

Laser 3 mW, 488 nm solid state

Laser life span 10,000 hours

RFU range 0 RFU to 1,000 RFU

Sensitivity 1 × 1011 M sodium fluorescein with signal-to-noise > 2

Wavelength range for
optics

Excitation: 488 nm

Detection: 500 nm to 750 nm (filter dependent)

Plate Specifications
This section describes how to configure the liquid-handling system to operate with the sample,
reagent, and outlet plates.

Sample Plate Specifications
To configure the liquid-handling system to operate with the sample plates, use the dimensions in
the following figures. The sample plate conforms to ANSI Society for Laboratory Automation and
Screening (SLAS) standards.
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Figure A-1 Sample Plate Dimensions

Dimension Value

Left edge to center of well
A1

14.38 mm

Top edge to center of well
A1

11.24 mm

Length at base 127.76 mm

Width at base 85.48 mm
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Figure A-2 Sample Plate Well Cross-Section Dimensions

Dimension Value

Well depth 22.10 mm

Well size at opening 5.00 mm

Pitch between wells 9.00 mm

Figure A-3 Sample Plate Side View Dimensions

Dimension Value

Overall height 31.25 mm

System Specifications
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Reagent Plate Specifications
To configure the liquid-handling system to operate with the reagent plates, use the dimensions in
the following figures.

Figure A-4 Reagent Plate Dimensions

Dimension Value

Left edge to center of well
A1

14.38 mm

Top edge to center of well
A1

11.24 mm

Length at base 127.76 mm

Width at base 85.48 mm
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Figure A-5 Reagent Plate Well Cross-Section Dimensions

Dimension Value

Well depth 29.95 mm

Well size at opening 5.00 × 8.27 mm

Pitch between wells 9.00 mm

Figure A-6 Reagent Plate Side View Dimensions

Dimension Value

Overall height 31.25 mm

Outlet Plate Specifications
To configure the liquid-handling system to operate with the outlet plates, use the dimensions in
the following figures.

System Specifications
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Figure A-7 Outlet Plate Dimensions

Dimension Value

Left edge to center of
column 1

14.38 mm

Top edge to top edge of
well

7.11 mm

Length at base 127.76 mm

Width at base 70.00 mm
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Figure A-8 Outlet Plate Well Cross-Section and Side-Section Dimensions

Dimension Value

Well depth 29.95 mm

Well size at opening 5.00 × 55.79 mm

Pitch between wells 9.00 mm

Figure A-9 Outlet Plate Side View Dimensions

Dimension Value

Overall height 31.25 mm

System Specifications
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Glossary of Symbols B
Note: Not all of the symbols in the following table are applicable to every instrument.

Symbol Description

Australian Regulatory Compliance Mark. Indicates that the
product complies with Australian Communications Media Authority
(ACMA) EMC Requirements.

Alternating current

A Amperes (current)

Asphyxiation Hazard

Authorized representative in the European community

Biohazard

CE Marking of Conformity

cCSAus mark. Indicates electrical safety certification for Canada
and USA.

Catalog number

Glossary of Symbols
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Symbol Description

Caution. Consult the instructions for information about a possible
hazard.
Note: In SCIEX documentation, this symbol identifies a personal
injury hazard.

  

China RoHS Caution Label. The electronic information product
contains certain toxic or hazardous substances. The center
number is the Environmentally Friendly Use Period (EFUP) date,
and indicates the number of calendar years the product can be
in operation. Upon the expiration of the EFUP, the product must
be immediately recycled. The circling arrows indicate the product
is recyclable. The date code on the label or product indicates the
date of manufacture.

China RoHS logo. The device does not contain toxic and
hazardous substances or elements above the maximum
concentration values and it is an environmentally-friendly product
that can be recycled and reused.

Consult instructions for use.

Crushing Hazard

cTUVus mark for TUV Rheinland of North America

Data Matrix symbol that can be scanned by a barcode reader to
obtain a unique device identifier (UDI)

Environmental Hazard

Ethernet connection

Glossary of Symbols
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Symbol Description

Explosion Hazard

Eye Injury Hazard

Fire Hazard

Flammable Chemical Hazard

Fragile

Fuse

Hz Hertz

International safety symbol "Caution, risk of electric shock" (ISO
3864), also known as High Voltage symbol
If the main cover must be removed, then contact a SCIEX
representative to prevent electric shock.

Hot Surface Hazard

In Vitro Diagnostic Device

Ionizing Radiation Hazard
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Symbol Description

Keep dry.

Do not expose to rain.

Relative humidity must not exceed 99%.

Keep upright.

Lacerate/Sever Hazard

Laser Radiation Hazard

Lifting Hazard

Magnetic Hazard

Manufacturer

Moving Parts Hazard

Pacemaker Hazard. No access to people with pacemakers.

Pinching Hazard
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Symbol Description

Pressurized Gas Hazard

Protective Earth (ground)

Puncture Hazard

Reactive Chemical Hazard

Serial number

Toxic Chemical Hazard

Transport and store the system within 66 kPa to 103 kPa.

Transport and store the system within 75 kPa to 101 kPa.

Transport and store the system within the specified minimum
(min) and maximum (max) levels of relative humidity,
noncondensing.

Transport and store the system within –30 °C to +45 °C.

Transport and store the system within –30 °C to +60 °C.
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Symbol Description

USB 2.0 connection

USB 3.0 connection

Ultraviolet Radiation Hazard

United Kingdom Conformity Assessment Mark

VA Volt Ampere (apparent power)

V Volts (voltage)

WEEE. Do not dispose of equipment as unsorted municipal
waste. Environmental Hazard

W Watts (power)

yyyy-mm-dd

Date of manufacture
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Glossary of Warnings C
Note: If any of the labels used to identify a component become detached, then contact a Field
Service Employee (FSE).

Label Translation (if applicable)

EN61326—1, EN61326—2-6, CLASS A,
GROUP 1, ISM EQUIPMENT

EN61326—1, EN61326—2-6, CLASS A,
GROUP 1, ISM EQUIPMENT

FCC Compliance. This device complies with
Part 15 of the FCC Rules. Operation is subject
to the following two conditions: (1) this device
may not cause harmful interference, and
(2) this device must accept any interference
received, including interference that may
cause undesired operation.

FCC Compliance. This device complies with
Part 15 of the FCC Rules. Operation is subject
to the following two conditions: (1) this device
may not cause harmful interference, and
(2) this device must accept any interference
received, including interference that may
cause undesired operation.

FOR RESEARCH USE ONLY. NOT FOR USE
IN DIAGNOSTIC PROCEDURES.

FOR RESEARCH USE ONLY. NOT FOR USE
IN DIAGNOSTIC PROCEDURES.

WARNING: Lifting Hazard.

FOUR PERSONS REQUIRED TO LIFT THIS
EQUIPMENT.

WARNING: Lifting Hazard.

FOUR PERSONS REQUIRED TO LIFT THIS
EQUIPMENT.

WARNING: NO USER SERVICEABLE PARTS
INSIDE. REFER SERVICING TO QUALIFIED
PERSONNEL.

WARNING: NO USER SERVICEABLE PARTS
INSIDE. REFER SERVICING TO QUALIFIED
PERSONNEL.

Note: Consult instructions for use.

WARNING: CANCER AND REPRODUCTIVE
HARM.

www.P65Warnings.ca.gov

WARNING: CANCER AND REPRODUCTIVE
HARM.

www.P65Warnings.ca.gov
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Contact Us

Customer Training
• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center
• SCIEX Now Learning Hub

Purchase Supplies and Reagents
Reorder SCIEX supplies and reagents online at store.sciex.com. To set up an order, use the
account number, found on the quote, order confirmation, or shipping documents. Currently,
customers in the United States, United Kingdom, and Germany have access to the online store,
but access will be extended to other countries in the future. For customers in other countries,
contact a local SCIEX representative.

SCIEX Support
SCIEX and its representatives maintain a staff of fully-trained service and technical specialists
located throughout the world. They can answer questions about the system or any technical
issues that might arise. For more information, visit the SCIEX website at sciex.com or contact us
in one of the following ways:

• sciex.com/contact-us

• sciex.com/request-support

CyberSecurity
For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation
This version of the document supercedes all previous versions of this document.

To view this document electronically, Adobe Acrobat Reader is required. To download the latest
version, go to https://get.adobe.com/reader.
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To find software product documentation, refer to the release notes or software installation guide
that comes with the software.

To find hardware product documentation, refer to the documentation that comes with the system
or component.

The latest versions of the documentation are available on the SCIEX website, at sciex.com/
customer-documents.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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